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Hard Copy Scanning
Hard copy used to be the end of the print process. Make it the beginning with
InfoPrint...

Highlights

• Take advantage of the IBM Infoprint Scan integrated solution, which combines
hardware and software in a single system

• Dial hardware and software services with a single phone number

• Clean up and align scanned images for printing

• Zone pages automatically using the solution-integrated Xerox DocuImage 620S or
Ricoh IS 420 (with IBM's exclusive image enhancement) scanner

• Save scanned files as PDF source for viewing, printing, and distribution on the Web

 

A local press republishes out-of-print books. With the Xerox DocuImage 620S, they can scan
fragile originals--even large-format picture books. With Infoprint Scan software, they erase the
comments inked in the margin in 1923 and collate pages from two incomplete copies to recreate
a perfect image of the first edition. Customers can link to sample chapters from their catalog on
the Web.

Another print house has a basement full of records dating from the founding of the company
through the year they switched to computers. The old ledgers and files take up needed space and
are vulnerable to fire, dampness, crumbling paper, and misfiling. With Infopint Scan, they
create electronic images of paper documents and adjust the images to improve legibility, then use
Infoprint Library to store their records in compact electronic format to be easily found and
printed at need.

Every semester, a professor updates a customized course textbook. The reproduction center at
the local university uses Infoprint Scan to scan in new journal articles, assemble them with
previously scanned articles, replace the course schedule, and print just enough copies for the students.
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Software Features

Infoprint Scan

Scanning

• Scan and manage all pages as one document

• Preview the effect of your scanner settings before scanning

• Create and retrieve templates to reuse optimized scanner settings

• Select standard or custom page sizes

• Maintain correct page order when scanning duplex documents on a simplex scanner

• Zone pages manually or automatically
Note: Automatic zoning for the Ricoh IS 420 is exclusive to IBM. Manual zoning is
supported only by the Xerox DocuImage 620S.

• Insert, replace, or delete single or multiple pages

• Save scanned documents in PDF format for viewing, printing, or Web distribution

• Save single pages in any Windows graphics format

Document Viewing

• Maintain detail and gray levels when viewing high-resolution binary images on a lower-
resolution display

• Zoom

• Pan

• Navigate by page: First, Last, Next, Previous, Go to Page

• Optionally view ruler and crosshairs for page alignment

Document Manipulation

Perform these functions on all pages, even pages, odd pages, a page range, or a list of pages:

• Page Alignment - visually align front to back or successive pages

• Page Edit - erase image areas
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• Page Copy - duplicate editing and alignment changes from one page to another

• Deskew - remove page skew introduced in scanning

• Despeckle - remove unwanted black specks from page

• AutoCrop - remove black or white borders caused by skew

• Register – Automatically position images at a fixed margin

• Rotate - change orientation of page in 90-degree increments

• Auto-Rotate - automatically turn all text images right side up

Printing

• Portrait or landscape orientation

• Layout options: multiple side-by-side copies, two successive pages side-by-side, or two
side-by side pages ordered for a folded booklet

• Combine scanned documents with documents in other formats in a single job

• Job scheduling options (rip, rip-and-hold, hold, print)

• Job retention after printing
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Hardware Features

 

Xerox DocuImage 620S Scanner Ricoh IS 420 Scanner

Bilevel, 256 levels of gray scanning modes Bilevel, 256 levels of gray scanning modes

Up to 400 dpi true sampling resolution or 600
dpi interpolated resolution

Up to 400 dpi true sampling resolution or 600
dpi interpolated resolution for documents up to
8.1 in. x 11.3 in. IBM's exclusive image
enhancement extends 600 dpi interpolated
resolution to documents up to 11 in. x 17 in.

Up to 20 pages per minute throughput at 600
dpi

Up to 19 pages per minute throughput at 400
dpi, letter size, portrait orientation

11.69 in. x 17 in. flatbed 11 in. x 17 in. flatbed

Minimum document size: 1 in. x 1 in. Minimum document size: 1 in. x 1 in.

Automatic document feeder (duplex) Automatic document feeder (simplex)

Control of highlights, midtones, shadows,
sharpness, brightness, and contrast

Control of brightness and contrast

Mixed text and halftone original scanning using
auto-segmentation

Image Processing Unit allows mixed text and
halftone original scanning

Power level: 100-120 or 200-240 VAC
(different models), 60/50 Hz

Power level: 100-120 or 220-240 VAC
(autoswitch), 60/50 Hz

Operational life: 5,000,000 scans Operational life: 5 years or 300,000 book scans
or 1,000,000 ADF scanned sheets (A4 size)

Price: $16,995 + $150 monthly maintenance
charge (as of May 1, 1998)

Price: $6,800 + $90 monthly maintenance
charge (as of May 1, 1998)

Information about the Xerox DocuImage 620 S scanner and the Ricoh IS 420 scanner was taken from publicly available
information sources as of 5/13/98.

Scalability

You can install Infoprint Scan on a PC without a scanner attached to edit scanned images, while
you dedicate the PC with a scanner to new input. Add more scanners to improve throughput or
more PCs to improve editing productivity.
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Prerequisites

Software Prerequisites

Windows® 95 or Windows NT operating system

Hardware Prerequisites

Advanced Function Presentation (AFP) printer

The following terms are trademarks of IBM Corporation in the United States and/or other
countries: IBM, Advanced Function Presentation, AFP, AIX, InfoColor, Infoprint, OS/2, Print
Services Facility, PSF, RISC System/6000 and RS/6000.

Microsoft, Windows, Windows 95 and Windows NT are all trademarks of the Microsoft
Corporation.

Other company, product and service names may be trademarks or service marks of others.
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Using Infoprint Scan Options
The IBM Infoprint Scan application provides a number of options that you can set for image
enhancement and for scanning. There are no particular settings for these options that will
guarantee the best quality output. You determine the settings you need for the best quality output
on a job-by-job basis by estimating the quality of your input, and by how the output appears on
observation. The information in this document will explain your options to help you determine
what settings you should use. Information is provided in the following topics:

Enhancing Images

Enhance Images when Scanning a New Document

Enhance Images in a Peviously Scanned
Document

Enhancement Options and Settings

Selecting Enhancement Options

Using the Scanner Settings Option

Scanner Settings

Advanced Template Settings

Notes:

Detailed information about using additional functions of Infoprint Scan can be found in the online help that
is provided with the program.

For you to carry out these procedures, it is assumed that:

• You have general knowledge of computers.

• IBM Infoprint Scan version 3.1 is installed and configured to communicate with the Infoprint
server.

• A scanner is attached to the workstation on which Infoprint Scan is installed.
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Enhancing Images
You can improve the appearance of a Scan document with Scan's image enhancement functions. You
can specify the settings used to enhance images by any of the following methods:

• Open Infoprint Scan and click Options in the menu bar and then select Enhance Settings... to
go directly to the Enhance Settings dialog box and specify the settings that you want used for
image enhancement. For more information, see Enhancement Options and Settings.

• You can specify the settings and have the Scan program enhance images immediately after the
document is initially scanned. For details, see Enhance Images when Scanning a New
Document.

• You can specify the settings and perform image enhancement functions on a document or
specified pages of a document that has already been scanned. For details, see Enhance the
Images in a Previously Scanned Document.

• You can specify the settings and have the Scan program enhance images when you scan to add
or replace pages in, or to append pages to a scanned document.



Enhance Images when Scanning a New Document
Note: If you have invoked Infoprint Scan from within the Infoprint Submit program, place
your original hardcopy document in the scanner, skip steps 1 through 4, and continue with
step 5. If you are using Scan as a stand-alone application, begin with step 1.

To scan and create a new document:

1. Open Infoprint Scan and place your original hardcopy document in the scanner.

2. Click on File in the menu bar and then select New Document....

3. In the Create New dialog box:

a. Select the directory into which you want to save the scanned document.
b. Type a name for the Scan document in the File name field. This name will also be
used for the name of the job ticket when you submit the document for printing.
c. In the Save as type field, be sure Job Ticket Files (*.jtk) is selected.
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4. Click on the Save button.

5. Click on File in the menu bar and then select Scan....

  

Page 9 of 32 5/4/99

 



6. In the Original area of the Scan Document dialog box, select:
One-sided if the original hardcopy document is printed on just the front side of the
paper.

Two-sided if the original hardcopy document is printed on both the front and back
sides of the paper. See Tips for Scanning Two-Sided Orginals for additional
information about scanning two-sided originals.

7. In the Template Selection list box, highlight the item that best describes the original
hardcopy document.

8. Click on the Settings button to view or change the scanner settings. (See Setting Up
the Scanner for additional information.)

9. Click on the Scan button.
During the scanning process, the Next Page to Scan area will display the number and
side of the sheet of paper that will be scanned next.
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10. When scanning has completed, the Append Scan Document dialog box will open. If
you want to scan more pages to add to specified locations in the new document,
place your hardcopy originals on the scanner, and repeat these instructions,
beginning with step 5.

 

 

11. Click on the Close button in the Append Scan Document dialog box to return to the
new, open document.

 

 

12. If you will be enhancing the image on just one page, make that page current by
using the options in the View menu.
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13. Click on Tools in the menu bar and then select Enhance....
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14. See Selecting Enhancement Options for information about the options in the Enhance
Image dialog box.

15. After the image enhancement has completed, click on File in the menu bar and then
select Close to close and save the document, or Exit to close and save the
document and exit the InfoPrint Scan application.

Tips for Scanning Two-Sided Orginals:

If you are using a simplex scanner, and you select Two-sided in the Original area, after the
front side has completed scanning, you will be prompted to turn over the original hardcopy
on the scanner so the back side can be scanned. When you are prompted:

a. Click on the OK button in the prompt window.
b. Turn over the original hardcopy in the scanner's document feeder.
c. Click on the Scan button again to begin scanning the back side.

If you are using a duplex scanner, and you select Two-sided in the Original area:

• If your original hardcopy has a standard, predefined paper size (such as, Letter), the
pages will be turned as they are scanned.

• If you define a custom paper size, after the front side has completed scanning, you
will be prompted to turn over the original hardcopy on the scanner so the back side
can be scanned. When you are prompted:

1.  Click on the OK button in the prompt window.
2.  Turn over the original hardcopy in the scanner's document feeder.
3.  Click on the Scan button again to begin scanning the back side.
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Enhance Images in a Previously Scanned Document
Note: Image enhancement permanently changes the image. After enhancing, you cannot
return the document to its original scanned image.

To enhance the images in a document that has been previously scanned:

 

 

 

1. Invoke InfoPrint Scan and click on File in the menu bar and then select Open... to
open the Scan document that you want to enhance.

 

 

2. If you will be enhancing the image on just one page, make that page current by
using the options in the View menu:
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3. Click on Tools in the menu bar and then select Enhance....
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4. See Selecting Enhancement Options for information about the options in the Enhance
Image dialog box.

5. After the image enhancement has completed, click on File in the menu bar and then
select Close to close and save the document, or Exit to close and save the
document and exit the InfoPrint Scan application.
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Enhancment Options and Settings
The following information is provided to describe the image enhancement options and to help you
determine what values to set for these options.

FYI: In case you're not familiar with the term, a pixel is another word for pel, or picture element. This is
defined as the smallest scanable, printable, or displayable unit on a physical medium or display surface.
The pixel, or pels per inch (ppi), is often used as a measurement of presentation granularity.

Deskew 

Deskew adjusts and corrects the angle at which a document is skewed, so the page and lines will be
aligned properly. Skew is the position of paper going through the scanner's paper path at a slight angle,
causing the scanned lines to not be aligned properly.

Deskew settings

In the Enhance Settings dialog box, move the slide bars in the Deskew Sensitivity area left to increase the
values or right to decrease the values.

• Acceptable Skew - sets the maximum amount of skew that is accepted. Any image with less
skew than the set value will not be corrected. Lowering the value will cause more images to be
corrected, and raising the value will cause fewer images to be corrected. Setting to a lower value
will result in higher scanning speed, since more images are left as is. For example, the original
default setting is 0.671%. This results in an image with no more than 150 horizontal pixels for
each vertical pixel of skew. A lower setting of 0.5% results in an image with no more than 200
horizontal pixels for each vertical pixel of skew, and a higher setting of 1% results in an image
with no more than 100 horizontal pixels for each vertical pixel of skew.

• Detection length - indicates the shortest line, in pixels, to be used to detect skew. This value
should be at least 25% larger than Acceptable Skew. The original default is 300 (1 inch at 300
dpi).

Note: See Fixed Image Size for important information related to using Deskew.

Despeckle 

Despeckle removes isolated, unwanted specks that may occur during scanning.
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Despeckle settings

In the Enhance Settings dialog box, move the slide bars in the Despeck Sensitivity area left to increase
the values or right to decrease the values.

• Isolated size - determines the size of isolated specks that are removed. Larger values can cause
periods and the dots on letters such as j to be removed. The original default is 4.

• Vertical size - examines each vertical line 1 pixel wide and deletes all groups of pixels with a
length less than the value specified. Larger values will remove larger specks. If the value is too
high small segments of characters will be removed. The original default is 0.

• Horizontal size - examines each horizontal line 1 pixel wide and deletes all pixels with a length
less than the value specified. Larger values will remove larger specks. If the value is too high
small segments of characters will be removed. The original default is 0.

Cropping 

Cropping eliminates an edge or border around a page that does not match the rest of the page. For
example, if you have specified that your Scan document should print on an 8.5 inch x 11 inch page, but
the original hardcopy document is smaller than 8.5 x 11 inches, without cropping, you would get black
borders on the scanned pages, the width of the difference in size between the original pages and the
scanned pages. With Auto-Crop turned on (selected) Scan will automatically eliminate the unwanted
borders.

Auto-Crop settings

In the Enhance Settings dialog box, click the arrow in the Cropping area and highlight an Auto-Crop
option.

• Auto-Crop - specifies the color of unwanted borders or edges that should be eliminated from
pages. Choices are:
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• Crop Black - Scan will eliminate black borders or edges from around pages. This is the
original default.

• Crop White - Scan will eliminate white borders or edges from around pages.

Registration 

Registration is used for page alignment. With this tool, you can position text horizontally and vertically on
the page to provide consistent side and top margins.

Registration settings

In the Enhance Settings dialog box, in the Registration area, type the values you want for the left and top
margins, and select or deselect the Central Focus and Add Only check boxes.

• Resultant Bind Margin - determines how many pixels will remain as the bind margin (for a two-
page spread - or facing pages - the left margin on an odd-numbered page, or the right margin on
an even-numbered page) after processing. Scan locates the bind edge of the text or data and
positions the bind edge of the image the specified number of pixels from the bind edge of the text
or data. Setting this value to 0 places the text or data flush with the bind edge of the image. A
negative value crops the specified number of pixels from the bind edge of the text or data.

• Resultant Outer Margin - determines how many pixels will remain as the outer margin (for a
two-page spread - or facing pages - the right margin on an odd-numbered page, or the left margin
on an even-numbered page) after processing. Scan locates the outer edge of the text or data and
positions the outer edge of the image the specified number of pixels from the outer edge of the
text or data. Setting this value to 0 places the text or data flush with the outer edge of the image.
A negative value crops the specified number of pixels from the outer edge of the text or data.

• Resultant Top Margin - determines how many pixels will remain as a top margin after
processing. Scan locates the topmost edge of the text or data and positions it a fixed distance
from the top edge of the image. Setting this value to 0 places the text or data flush with the top
edge of the image. A negative value crops the specified number of pixels from the top edge of the
text or data.

• Central Focus - causes Scan to register using only the middle portion of the image border. This
is useful for ignoring edge noise, letterheads, and logos. You can activate this for the resultant
bind margin, the resultant outer margin, the resultant top margin, any or all of these margins at
one time, or none of the margins.
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• Add Only - causes Scan to expand the current margin (if it is smaller than the specified value) to
the size specified for the Resultant Bind, Outer, or Top Margin. You can activate this for the
resultant bind margin, the resultant outer margin, the resultant top margin, any or all of these
margins at one time, or none of the margins.

Note: To determine the value in pixels to enter for the resultant bind, outer, and top margins, multiply the
dimension you want for the margin by the scanned resolution of the image.

Example:

As an example, let's say you want to center the body of text on a 6-inch wide x 9-inch long page, so that
both the bind and the outer margins are the same. Assume that you have scanned the image at 600 dpi.

1. Measure the line length of the text, using the longest line on the page. For this example, assume
that the line length is 4.5 inches.

2. Subtract the line length from the width of the page.

6.0 inches – 4.5 inches = 1.5 inches

This leaves a total of 1.5 inches for the margins.

3. Since there are two margins, divide the remainder by 2.

1.5 inches ÷ 2 = .75 inch

For this example, the resultant margins are each .75 inch.

4. To convert this to pixels, multiply the width of each margin by the scanned resolution (600 dpi for
this example).

.75 inch x 600 dpi = 450 pixels

5. For this example, you would enter 450 for the value in both the Resultant Bind Margin and
Resultant Outer Margin fields.

Note: Remember to adjust the values if you want a wider bind margin than outer margin, to allow
additional room for 3-hole punching, saddle stitching, or other types of binding. For example, if you want
the bind margin to be 1 inch, and the outer margin to be .5 inch, for an image scanned at 600 dpi the
resultant bind margin will be 600 pixels (1 inch x 600 dpi), and the resultant outer margin will be 300
pixels (.5 inch x 600 dpi).

Fixed Image Size

If the Do not allow Enhance to modify image size check box is not selected, Enhance will proportionally
resize the image, when necessary, to fit on the page. When the box is selected (checked), Enhance will
not resize the image.

• Be sure to check this box when Deskew is selected.
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• Be sure that this box is not checked when you have selected to Rotate the image and want the
entire image to fit on the rotated page (such as when an image with a portrait, or vertical
orientation is rotated 90 or 270 degrees to a landscape, or horizontal orientation).

Notes:

• When you use Registration, you should also activate Deskew unless you know that the original
is perfectly straight.

• You can activate and set the parameters for horizontal (bind and outer edges of an image) and
vertical (top edge) registration separately.

• For most operations where you require consistent bind and outer margins, you should activate
horizontal registration. In many cases, you can leave vertical registration deactivated. For
applications where precise text location is important, you should activate both horizontal and
vertical registration.

• When you have finished specifying all of the settings, click on the Save button in the Enhance
Settings dialog box.

• To return all of the settings to their original defaults, click on the Default button in the Enhance
Settings dialog box.



Selecting Enhancement Options
You can select the enhancement options that you want Scan to perform when a new or
previously created Scan document is open, as described in Enhance Images when Scanning
a New Document, or Enhance Images in a Previously Scanned Document. With a Scan
document open, do the following:

1. Click on Tools in the menu bar and then select Enhance…
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2. Select from one of the following in the Apply to area of the Enhance Image dialog
box:

• Current page - to apply the enhancements only to the page that is currently
displayed.

• Document - to apply the enhancements to the document as specified with:

• All Pages - to apply the enhancements to all pages in the document.

• Even Pages - to apply the enhancements to all even-numbered pages.

• Odd Pages - to apply the enhancements to all odd-numbered pages.

• Pages _________ - to apply the enhancements to a specific page or pages, or to a
range of pages.

• For an individual page, type the page number of the page you want to print in
the field provided.

• For specific pages, type the numbers of all of the pages you want to print,
each separated by a comma (such as, 3,9,11,24).

• For a range of pages, type the number of the first and last pages you want
included, separated by a dash (such as, 15-20).

• You can also specify individual pages along with a range of pages (such as,
3,9,11,24,15-20).

• Do not include spaces after the commas.

 

3. In the Enhance Options area, you can select the following options (see Enhancement
Options and Settings for additional information):

• Deskew - adjusts and corrects the angle at which a document is skewed, so
the page and lines are aligned properly.

• Despeckle - removes isolated, unwanted specks that may occur during
scanning.

• Auto-Crop - eliminates an edge or border around a page that does not match
the rest of the page
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• AutoRotate Portrait - when this is selected, if Scan finds a page of text that
is upside down, it will automatically rotate the page, so that the text is right
side up.

• Registration - positions text horizontally and/or vertically on the page to
provide consistent side and top margins.

• Invert Image - reverses the image so that all blacks are white and all whites
are black. On a "positive" image, the effect is similar to that of a photographic
negative. (Conversely, a negative image is made positive.)

  

  

Rotate - rotates pages by a specified number of degrees from their current
orientation. Options include:
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• None - do not rotate the page

• 90 Degrees Clockwise -rotate the page 90 degrees clockwise (1/4
turn) from the current orientation. For example, this would cause a
portrait (vertical) page to display or print in a landscape (horizontal)
format.

• 180 Degrees Clockwise - rotate the page 180 degrees clockwise
(1/2 turn) from the current orientation. For example, a portrait
(vertical) page would display or print with the head and foot areas of
the page in reversed positions.

• 270 Degrees Clockwise - rotate the page 270 degrees clockwise
(3/4 turn) from the current orientation. For example, a landscape
(horizontal) page would display or print with the head and foot areas
of the page in reversed positions.

 Notes:

• Any or all of the enhancement options can be selected at one time.

• See Fixed Image Size for important information related to using Deskew and
Rotate.

1.  Click on the Change Settings button to modify the enhancement settings. See
Enhancement Options and Settings for information.

2. Click on the Enhance button to enhance the image(s) based on the default or your
modified settings.

3. Click on the OK button in the message window when the image enhancement is
completed.
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Using the Scanner Settings Option
Infoprint Scan uses templates to tell the scanner how a page should be scanned. Several templates are
provided with the program. These templates contain default scanner settings based on standard types of
hardcopy originals. You can use these templates as provided, modify the templates, or define new
templates.

To view, modify, or create a template, invoke Infoprint Scan and open the Scanner Settings dialog box by
one of the following methods:

• After you have opened a new or an existing document, click on Options in the menu bar and
then select Scanner Settings.... (If a document is not open, the option will not be available.)

or
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• Click on the Settings button when the Scan Document or the Append Scan Document dialog box
is displayed to open the Scanner Settings dialog box.

In the Scanner Settings dialog box, you can create a new template or modify an existing template.

To create a new template:

• In the List of Scanner Templates, highlight a template on which to base the new template. The
Options area shows the current settings in the highlighted template.

• Click on the Create button.

To modify an existing template:

• Highlight the template in the List of Scanner Templates. The Options area shows the current
settings in the highlighted template.

• Click on the Change button.
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These actions will display the Create Template or Change Template dialog box.

1. Type a Name for the template (for Change, the template name will already be displayed).

2. Select the Type of Original for which the template will be used.

3. In the Options area:

a. Select the size of the original in the list in the Original Size drop box. (Select Custom in the
Original Size list to define an original size that is not listed.)
b. Select the Resolution at which to scan the hardcopy original from the list in the Resolution drop
box.
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4. Specify values for the scanner settings. The available options will change, depending on the
scanner that is installed and what type of original you specify. Only the options that are
associated with the scanner and specified type of original will be available for modification. All of
the possible options are described in Advanced Scanner Settings.

5. If it is available for your scanner and the specified type of original, click on the More button to see
additional, advanced scanner setting options.

a. Specify values for the options available in the Advanced Template Settings dialog box. The
possible options are described in Advanced Template Settings.
b. Click on the OK button to save your settings and return to the Create or Change Template
dialog box.

6. In the Create or Change Template dialog box, click on the Preview button to see the effect of
your changed settings as you create or modify the template.

7. Click on the Save button in the Create or Change Template dialog box when you have finished
modifying the settings.

8. Click on the Done button in the Scanner Settings dialog box.

Tips for Using the Preview Option:

• Preview will actually scan and display a page, so be sure to place a hardcopy original page on
the scanner.

• When previewing, if the Scanner Settings dialog box is accessed from the Scan Document, or
Append Scan Document dialog box, the options in the View menu will not be available, but you
can use the + key and - key to zoom in and out on the previewed page. If the Scanner Settings
dialog box is accessed from the Options menu, the View menu options will be available.

• If you have changed one of the supplied templates, you can return it to its original settings by
clicking on the Defaults button in the Create or Change Template dialog box.
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Scanner Settings
You can specify values for the following settings in a scanning template:

Original size

This is the paper size of the hardcopy original document, before scanning.

Resolution

This is the resolution, in dots per inch (dpi), at which you want to scan the hardcopy original document.
The higher the scan resolution you set, the finer the detail, but be aware that a high resolution image
requires more memory space and processing time than a low resolution image. You will generally get
high quality results if the scanning resolution is set to the resolution of your output device (the print
resolution of the InfoPrint 60 is 600 dpi). A lower resolution will result in lower quality, and a higher
resolution is a waste of memory.

The Original size and Resolution options are always available. The following are all of the remaining
scanner setting options that are provided with Scan. Only the options that are associated with the scanner
that is installed, and with the type of original that is specified are displayed and available for modification
at any given time.

Brightness

A high setting results in a lighter overall image, and a low setting results in a darker overall image. When
you scan a dark image, the darker areas may appear as deep black, even though they contain gray
shades. Increasing the setting will cause the shades of gray to appear. Conversely, if a light image
appears too white, decrease the setting.

Threshold Types

The threshold values determine the degrees of darks and lights at which images are scanned. The
following threshold types are available:

Manual - you determine the threshold. For light images, set a higher threshold. For dark images,
set a lower threshold.
Automatic - the scanner’s image processing unit determines the appropriate threshold.
Enhance Light - makes light lines darker.
Remove Background - removes a light, overall background shade or color.

Filter type

The following filter types are available:

None - no filter is used.
Line Bolding - adds pixels to thin lines and characters.
Edge Extract - creates outlines of text and graphics, displaying only the edges.
Remove Pasteup Lines - removes imperfections from areas in an image where manual pasting
has occurred on the original and has left lines around the added image area.

Contrast

Controls the difference between the light areas and the dark areas of an image. A high setting
emphasizes black and white, leaving few middle gray shades; a low setting emphasizes the middle
gray shades, at the expense of black and white.
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Sharpness

The degree to which an image appears crisp or contains well-defined edges. A lower level of sharpness
will soften or blur the lines of an image. A higher level of sharpness will clarify or increase the lines of an
image.

Reduce Moiré

Lessens the appearance of moiré patterns. A moiré pattern is an undesirable screen pattern caused by
incorrect screen angles of overprinting halftones.

Grayscale

Normal - emphasizes contrast slightly to improve image.
Sharp - emphasizes contrast to a greater degree to sharpen image.
Linear - outputs image as it was scanned, with no adjustment for contrast.
Smooth - weakens contrast to soften image.

Enhance type

Choose one of the following, based on the composition of your original hardcopy:

Text and Halftone
Pictures (photos)
Color Halftones
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Advanced Template Settings
If it is available for your scanner, and for the type of original you specified, you can click on the More
button in either the Create Template or Change Template dialog box to see additional, advanced scanner
setting options. Only the options that are associated with the scanner that is installed, and with the type of
original that is specified are displayed and available for modification at any given time.

The following are all of the possible advanced template setting options that can be provided in the
Advanced Template Settings dialog box.

Highlight
s

Highlights are the white and very light gray areas in an image. Use the slide bar to increase
or decrease the whitest or lightest areas of the image.

Midtones Midtones are the light and medium grays in an image. Use the slide bar to increase or
decrease the appearance of the image midtones.

Shadows Shadows are the darkest or blackest areas of an image. Use the slide bar to increase or
decrease the appearance of image shadows.

Screen Specify a halftone screen value, in units of lines per inch, to apply to images when scanning.

Descreen Specify the value of the halftone screen, in units of lines per inch, that you want to remove
from an image when scanning.
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